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WOW! It hasn't seemed like enough time has gone by, but another holiday season has burst upon us with a fury.
Closer to "home," PCLinuxOS has seen updated ISOs released, along with a couple of more
"mini" releases. Texstar is working on a 64 bit version of PCLinuxOS. KDE 4.5.4 has reached the
testing section of the repo, while reports of the first beta of 4.6.1 has made its way from the KDE
developers. The Xfce developers are making some progress towards the much anticipated Xfce
4.8. LibreOffice, which has absorbed Go­OO (the version of OO.o used by PCLinuxOS), has
entered the third beta phase that will lead up to its inaugural release. More details are coming forth
about the much anticipated Gnome 3.0. Novell gets bought out by Attachmate, with significant sale
of certain intellectual property rights to a consortium of software companies headed up by
Microsoft. (Don't worry. The early reports are that Novell, as a subsidiary of Attachmate, has
retained its ownership of Unix patents.) With so much going on, it's no wonder that the holidays
seemed to sneak up on us!
This month, The NEW PCLinuxOS Magazine starts a series of articles looking at e17, a.k.a. Enlightenment. We'll
dig into e17 much in the same fashion that we dug into KDE 4, Xfce and LXDE. To kick things off for our look at
e17, I've written the e17: An Overview article that takes an overall look at e17, where it comes from, and where it
may be heading. I've also written the e17: Beginner Desktop Tweaks article to help you to start tailoring your e17
desktop. Finally, Meemaw digs deep into Shelves and Drawers, in her e17: Shelves & Drawers Explained article.
Meemaw also finishes up her series of articles on OpenOffice 3.2, with her OpenOffice 3.2, Part 7: Letters &
Labels article. Darrel Johnston takes another look at yet another free, open source alternate operating system,
with his Alternate OS: Kolibri, Part 1 article. Gary Ratliff, Sr. returns with another installment in his programming
languages series, with his Computer Languages A to Z: Tcl/Tk article. Daniel Meiß­Wilhelm (Leiche) returns this
month, profiling another of his creations in the PCLinuxOS repository, with his Repo Spotlight: PCLinuxOS FLV
Player & Converter article. Pete Kelly returns with another helpful article, with his Monitor Your System With
GKrellM article.
Meemaw has also reviewed yet another game for this month's Game Zone: Hotei's Jewels ­ Relax article. I
continue my look at Firefox Add­ons, with my Firefox Add­ons: CoLT article. ms_meme has graced us with two
different ms_meme's Nook entries, plus another installment in her Forum Foibles column. Mark Szorady is back,
with his monthly Double Take & Mark's Quick Gimp Tip column.
Be on the lookout next month for a new masthead design by Timeth. Starting with the January 2011 issue, we will
be dropping the NEW portion of the magazine's title, shortening it to simply The PCLinuxOS Magazine. Only the
name changes. I, along with the rest of the magazine staff, are still here, and we're still going to strive to bring you
the wide variety of helpful articles that we have done for the last 18 months.
Until then, I hope everyone enjoys the holiday season. I wish peace, happiness, serenity and tranquility for each
and every one of you.

Welcome From The Chief EditorWelcome From The Chief Editor
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by Paul Arnote (parnote) Similar but different would be an excellent way to
describe e17, also known as Enlightenment, or
simply "E." In many ways, it brings a whole new way

of working with and thinking about the Linux
desktop. It does so without throwing away
everything you've become accustomed to in a Linux
desktop, while providing a lot of eye­candy, all within
a small memory footprint. As such, e17 runs
exceptionally well on older, less capable hardware.
E17 really is a window manager for the X11 window
system on Linux. It's not a full­fledged desktop
environment, as KDE, Gnome, Xfce and LXDE are.
The cornerstones to the popularity of e17 are its
modularity and its ability to be heavily customized to
the users needs. If you don't use or need a module,
you can simply unload it without sacrificing system
stability and features. With the ability to customize
the e17 desktop, it means that users can create their
own, unique user experience, tailoring the desktop
to exactly match the way they work with the
computer.

History
The first release of Enlightenment was in 1997, by
Carsten Haitzler, a.k.a. Rasterman. Under
development for more than a decade, the latest
stable release is version E16 1.0.4. However,
PCLinuxOS uses E17, which just moved from alpha
to beta status within the last month or two. The
rewrite of Enlightenment for E17 revolved around
making Enlightenment more modular, via the EFL
(Enlightenment Foundation Libraries). By breaking
the window manager into smaller modules, the
Enlightenment developers hope to make
maintenance easier. It will also mean that only the
affected libraries (and the applications that call them)

My customized e17 desktop, running the PCLinuxOS­e17 Light ISO on an IBM Thinkpad T23 with a P3 1.13 GHz
processor and 512 MB RAM.

e17: An Overviewe17: An Overview
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will need to be rebuilt as Enlightenment continues to
grow and mature.

Doing More With Less

The efficient use of modules allows E programmers
to "do more with less." In essence, the programmers
focus on the meat and functionality of a program,
and independent "edje" files are responsible for
handling the finer points of the graphical user
interface. Thus, they don't have to spend large
quantities of time on designing and redesigning the
user interface (UI) for each and every application
that is written.

Memory & System Requirements
The Enlightenment web site lists the minimum
memory requirements for running Linux +
Enlightenment as 16 MB (and possibly as low as 8
MB). In order to experience the full "Enlightenment
experience," 64 MB (and greater) are
recommended. For PCLinuxOS­e17, 512 MB RAM
is recommended, although it will run and install with
less than one­half that amount of system memory.
While Linux desktop systems represent the most
common tool used to develop the Enlightenment and

EFL (due to the speed), development is done with
the goal that it also runs on mobile phones,
televisions, netbooks and more. In fact, there are
several major electronics manufacturers who have
partnered with the Enlightenment development
team, including Samsung.
As a result, Enlightenment and EFL have been
successfully run and tested on x86­32, x86­64,
Atom, PowerPC, ARM, MIPS, Sparc, and other
architectures. In fact, as little as a 200 MHz ARM
core will provide sufficient processing power to
adequately run Enlightenment and EFL.
The graphic needs of Enlightenment are quite
modest, as well. It is designed to run on screens as
small as QVGA (320 x 240), but the graphics
architecture is designed to scale to full­HD (1920 x
1080) and beyond, using displays ranging from 8­bit
paletted colors all the way up to full 24/32 bit true
color displays.

Impressions
The "full" Enlightenment ISO, containing a wide
range of KDE applications, is intended for computers
with more modern processors (although, it will
typically run quite well on older computers). The
"light" Enlightenment ISO is intended for older,
slower computers, and uses lighter weight Gtk+
applications. On my IBM Thinkpad T23 (P3, 1.13
GHz, 512 MB RAM, 8 MB S3 Video), the light
version runs faster and is more responsive. But it's
worth mentioning that the full version also runs quite
well. With the full version, I experienced brisk
performance until Qt4/KDE libraries had to be

loaded in to launch a KDE application. Then, there
was about a 10 second delay before the display of
the KDE application on this older computer. I
experienced no such delays when launching the
Gtk+ applications in the light version.
The light version comes heavily customized in the
default installation. While experienced e17 users will
love its flash and glitz, new users may have some
difficulty in figuring out what to do and where to go,
since nothing is where you are accustomed to
looking for it on the other desktops in the other
versions of PCLinuxOS. Fortunately, Texstar has
created a package that will make the light version
look and act more like the other desktop
environments. New e17 users may find installing the
package (called econfig­light) from Synaptic helpful
in getting their bearings. After all, there are plenty of
other things to learn about and explore in e17, and
that learning curve is made a lot easier if users have
a familiar looking interface to operate in. Users can
revert back to the flashy, glitzy screen layout at any
time, simply by installing the econfig­itask package
from Synaptic.

Conclusions
If you are looking for a Linux desktop that is fast and
responsive, that uses a minimum of memory, and
that has ample amounts of eye candy, then e17
definitely is for you. Overall, I've found e17 to be
very stable. Its ability to be customized allows users
to tweak and tune just about every aspect of the
interface, and to create an e17 user experience that
is uniquely their own.

e17: An Overview

http://www.enlightenment.org/


6

Screenshot ShowcaseScreenshot Showcase

Posted by witchart, November 16, 2010, running Gnome.
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by Meemaw
Now that we've covered most of the parts of
OpenOffice, we need to put our new­found
knowledge to work.
Labels
Most of us have used labels for one thing or another.
I make address labels for my own address, as well
as a few of the companies we pay bills to on a
regular basis. At work I have return address labels
for envelopes that need them, and also make
mailing labels when I send postcards or newsletters.
They are very handy and easy to make. The first
thing to make is a whole page of address labels.
Open a new text document. With your blank
document open, click on 'File > New > Labels' and
you will get this window:

There are three tabs in this window. The Labels tab
lets you pull up the brand name label you are using,
plus the specific type you want to print. I use the
Avery 5160 a lot. They are 2 5/8 inches wide and an
inch tall. Don't worry about the top part yet. The
Format tab is to make sure of the borders of the
labels, how far from the top of the page the label
starts, how far from the left edge of the page the
label starts, if there is a space between two labels or
not, and so on. In a brand name label, all of those
are already set. The third tab, Options, gives you a
place to configure your printer, although I've never
had to change any of the settings. You also want to
check the box in front of "Synchonize Contents" as
it will be useful. If for some reason you want to print
a single label, you can select that radio button and
fill in the column and row location.

Click New Document, and you will see a new
page with grid lines that should match your label
page. Notice there is an extra little window with
one button, Synchronize Labels. We'll use this in
a few minutes.

Whatever you want on your page of labels should be
typed into the top left box.You are going to use this
one box to get your label the way you want it to look.
Bear in mind that the lines in your grid correspond
closely to the places on the label where the paper is
cut. You probably don't want the first letter of your
name on one of those cuts, so leave a space on the

OpenOffice 3.2, Part 7: Labels & LettersOpenOffice 3.2, Part 7: Labels & Letters
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left side, or center your labels. You can also highlight
the text and change the font or size.
When you have it just the way you want it, click on
"Synchronize Labels." You'll see that OO has filled
in every other label on the page with text identical to
the one you just created.

You should now be able to save & print your labels.
Mail Merge Labels & Letters
Most of the time you write a letter for just one
person. However, we might occasionally send a form
letter to several people. If you have your
spreadsheet with your addresses, you can print
labels for your envelopes, and also put the
recipient's name in the letter by the use of mail
merge. Let's do the labels first. These are a little
different from the ones we did above because all the
labels will have different information.

NOTE: Remember in the last article, when I stated
that you could open your spreadsheet in OOBase
and not have to recreate it? We HAVE to do that to
use it as a database for our labels & letters. So if it is
in spreadsheet form, you need to Open > Database,
then use the dropdown menu, which connects to an
already existing database rather than the New
Database choice.

In the list it says
Spreadsheet, so
choose that. You
will get the
window asking
you to open that
spreadsheet,
then just like
before in
OOBase, you will
choose Register
the Database.

If you want to edit it further, you can,
and you will need to save it as a
database. Now your spreadsheet
can be used as a database for your
labels and letters.
Open New > Labels, just like you
did above. Now, we're going to point
the wizard at your database, so click
on Database at the top, and choose
yours. Also, choose the table your
information is in. Some of the more
detailed databases may have more
than one table ­ that's like having a
spreadsheet with more than one
sheet of information.

You should see your field names in the next box.
Choose them in order and click the arrow to add
them to your label. The reason I said choose them in
order is because OO puts each one in a line, one
right after the last one it entered. If you choose first
name, then last name, you'll have the first line of
your label already correct (put a space in between
them, then hit Return to put the address on the
second line).

When you get
your fields
entered, click on
the Options tab
and make sure
Synchronize
Contents is still
checked, then
click Create.

OpenOffice 3.2, Part 7: Labels & Letters
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It looks familiar, doesn't it? You can get the top left
one laid out as you desire, then click the
Synchronize Labels button.

Your layout is finished. Now we have to put the
names in. From this document, go to Tools > Mail
Merge Wizard. Since your document is all laid out,
you want to click next without doing anything until
you get to the end where it says save or print. If you
move that window, you will see that the database
has been merged and your labels have the actual
names and addresses on them.

Whatever action you choose above will have
different buttons below, but from here you can load
your labels and print them (the third line down says
Print merged document).
Now we need to do our letters. In my job, I
occasionally have to do form letters (inviting a group
of people to a dinner, for example). Since each letter
says the same thing except for the address and

salutation, and I don't want to type each address
separately, I will mail merge the names and
addresses onto the letter.
Again, open a text document. You can type your
letter first, or you can edit it in the course of the mail
merge. I have several letters already done at work,
and just edit the contents when needed. Whichever
you do, to start the mail merge, you should go to
Tools > Mail Merge Wizard. We'll use more of it this
time. If you have already typed your letter, choose
Use Current Document. Each step is listed on the
left side of the window, so you can always see
where you are. Your document type is Letter. In step
3, you are asked what list to use, and if you want to
insert an address block. Click Select Address List
and choose your database. If you are going to have
an address block at the top of your letter, place a
check mark in the box next to number 2, then click
More to be able to edit your address block so it's
correct. In the USA, the postal service frowns on
having the zip code in front of the city name!

OpenOffice 3.2, Part 7: Labels & Letters
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You will then get a window that allows you to choose
and edit an address block.

The next step is Create Salutation, but I think we
can do it easier later. It's pretty straightforward, so
you can add one from there if it's the salutation you
want, or click Next. In Adjust Layout, you can see a
sample of your letter to make sure the address block
is in the correct spot (down from the top of the
letter). You can just change the measurement to
alter the location, and also move your salutation up
or down. The letter text needs to be moved up on
mine, but I'll do that later as well.

The next step is Edit Document, if needed. Here
you can insert a field for some other special part of
your letter (and I can move the body of my letter up).
I didn't like any of the salutations so I inserted the
First Name from my database. Put the cursor where
you want the field, then go to Insert > Fields >
Other. The last tab is Database, and you should see
yours there. Click on the triangle to view the table &
contents, and choose the field you want.

There is also a button to go back to the wizard and
finish your setup. From there you can personalize
each letter further if you wish, then save and print.

OpenOffice 3.2, Part 7: Labels & Letters
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I hope this has been helpful! I have done some
research on the internet and I have found many
articles by Solveig Haugland. She is an OpenOffice
how­to expert. The links below should help if you
need any more information.
http://www.openoffice.blogs.com/
http://blog.worldlabel.com/mail­merge­in­
openofficeorg­everything­you­need­to­know
http://blog.worldlabel.com/2010/generating­labels­
and­business­cards­in­openoffice­org.html

OpenOffice 3.2, Part 7: Labels & Letters

Screenshot ShowcaseScreenshot Showcase

Posted by cstrike77, November 3, 2010, running LXDE.

http://pclinuxos.com/?page_id=7
http://www.openoffice.blogs.com/
http://blog.worldlabel.com/mail-merge-in-openofficeorg-everything-you-need-to-know
http://blog.worldlabel.com/2010/generating-labels-and-business-cards-in-openoffice-org.html
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Answers on Page 42.

Double Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp Tip

When working in Gimp, I'm usually
clicking around so fast that I sometimes
select the wrong tool. That's not a big
deal. I just go back up to the menu and
select the tool I need. But sometimes I
accidentally move a menu off the toolbar
dock. I then have to take a few moments
to create a new tab menu on the dock. For
instance, on the right hand dock, I have
tabs for Layer,s, Channels, Navigation,
Paths, and History. Every once in a while,
because I'm clicking around so fast, I'll

Mark's Quick Gimp Tip
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unintentionally detach one
of those tabs from the dock.
It then becomes it's own
window and I can position it
anywhere on screen. And

that's a nice feature. But I like to have my
tool/menu tabs on the dock. So, to avoid
detaching menu tabs, simply left click on
the arrow in the right hand dock and select
“Lock Tab to Dock.” Do this for each tab in
the dock. Now, no matter how fast you
click around, your tabs will remain in the
dock until you decide that you want to
detach and move them elsewhere.

Find at least seven differences between cartoons. ©2
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­Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.

http://www.georgetoon.com
mailto:georgetoon@gmail.com
http://www.KDE.org/
http://www.gimp.org/
http://www.georgetoon.com/blog
http://www.gimp.org/
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Who wears a star up on his chest
Tex wears a star up on his chest
Who made an OS that's the best
Tex made an OS that's the best
Star on chest OS that's best
Must be Tex Must be Tex Tex Texstar

Who wears a ten gallon on his head
Tex wears a ten gallon on his head
Who leads us where we want to be lead
Tex leads us where we want to be lead
On his head Want to be lead
Star on chest OS that's best
Must be Tex Must be Tex Tex Texstar

Who do we cheer for everyday
Tex is who we cheer for everyday
Who hears us say Yippe Yi Yay
Tex hears us say Yippy Yi Yay
Everyday Yippie Yi Ya
On his head Want to be lead
Star on chest OS that's best
Must be Tex Must be Tex Tex Texstar

Who makes Linux easy to use
Tex makes Linux easy to use
Who makes Linux the one to choose
Tex makes Linux the one choose
One to choose Easy to use
Everyday Yippie Yi Ya
On his head Want to be lead
Star on chest OS that's best
Must be Tex Must be Tex Tex Texstar

OGG MP3

ms_meme's Nook: Must Be Texstarms_meme's Nook: Must Be Texstar

http://www.pclosmag.com/html/Issues/201012/files/mustbetex.ogg
http://www.pclosmag.com/html/Issues/201012/files/mustbetex.mp3
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E17: Shelves & Drawers ExplainedE17: Shelves & Drawers Explained
by Meemaw
E17 has it's own method of configuration. Rather
than having a panel, there is a shelf for your desktop
items. One of the things you can add to a shelf is a
drawer. Different, huh? I'm going to try to explain
these two things for you.
Shelf
In a default installation of e17 (the full version), the
shelf is at the bottom of the screen and contains the
Start menu, Deskshow (e17's version of Show the
Desktop), an IBar, the task list, the Mixer (speaker),
the Pager, a System Tray and the clock (see bottom
of page.)

The Deskshow looks like a window between the
Start Menu and the IBar. The IBar is a program
launcher and in the default install, it contains
Configure Your Computer (PCC), Synaptic, a
terminal, and Dolphin File Manager. The default
Pager shows only 2 desktops.
Each of these items can be configured the way you
want them. When you right­click an item, you will
usually get two choices: configure the shelf or the
item. So if you want to change to 4 desktops and
right click on Pager, you get a menu saying Shelf
Bottom and Pager. It says Shelf Bottom because
the shelves are distinguished from each other by
their location on the screen ­ this one is at the
Bottom. Choose Gadget Pager and you will get the
following menu (top right):

If you click on the top item 'Virtual Desktop
Settings' you get the screen that lets you choose
the number of desktops you want. Going to Gadget
Pager > Settings, you can choose how you want it
all to behave. There is a basic screen and an
advanced screen with more choices. (If you make a
change, remember to click on Apply to save it before
closing each window).

Each of the items on your shelf can be configured
similarly. You can even add new shelves. In your
menu you can click on Settings > Shelves and you
will get a window showing the shelves you have.
From there you can choose to Add or Delete a shelf.
E17, by default, adds the new shelf at bottom right,
but by clicking the Setup button, you can change
position of the shelf. Then to configure the contents,
you should right click the shelf and choose Contents
from the menu.

Choose the
contents from
the menu that
appears. Notice
there is a
Settings menu
there as well, so
you can do
everything by
right clicking the
shelf.
From the
Setting menu,
you can
increase the
size of the shelf.
This one is 84
pixels high (next
page.) While I

have my clock somewhere else and wouldn't want a
shelf with only a clock, many people configure their
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desktops differently.
This illustration was just
to show what can be
done.

Drawers
A drawer is another kind of quick launcher, but rather
than having the programs you want to launch in a
row, like the IBar, there is a single icon and clicking
on it gives you a pop­up menu containing your
desired items. It's nice because it takes up less
space on your shelf.
The drawer must be
loaded before it can be
used, but it's already
there in modules. Just
go to Settings >
Modules and you will
see a list of modules.
Scroll down to Drawer
and click on it, then
click on Load.
Now you will see a
drawer on your shelf.
Right click it and

choose Gadget Drawer > Settings.

From here you
can choose what
you want in your
drawer, and how
you want it to
look. Mine is a
launcher in list
view, but you can
configure it

differently. It can be a window list, history launcher or
directory launcher, and can view as a list or in a grid
(group of icons). The text in the list can be different
sizes, but the grid can't be modified.

The settings are versatile because you can even
choose the order in which your items are displayed
by moving them up and down in the list during
configuration. Notice in the top window that
Selection is highlighted. That is where you choose
your contents, but right next to it, you can change
the Order of the list.

Notice behind the settings where it says Selected
Bar Source. The default is the list of programs if you
are doing a launcher. If you want two different
drawers, you will need to designate two different
sources, or both your drawers (or your drawer and
your IBar, for that matter)
will contain the same thing.
I have added another
source for my drawer and
named it Games, and
added five games to it. It
uses the same application
list but tells the system that
this is different from the
other drawer or IBar. My
IBar at the top has my
most used programs in it,
and my drawer contains
the games I like.

E17: Shelves & Drawers Explained
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In our exploration of E17, we have noticed that there
seems to be a problem adding a drawer to the
desktop. You can create a shelf and add your drawer

there, but adding it straight to the desktop has
resulted in some strange results. Be cautious!

E17: Shelves & Drawers Explained

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.My e17 desktop with an IBar at top and my games drawer on the shelf.

mailto:pclinuxos.mag@gmail.com
http://www.enkiconsulting.net
http://www.oneclicklinux.com
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by Pete Kelly (critter)

A driver has lots of information available to enable
him to monitor things like the engine speed and
temperature, or the amount of fuel remaining and
distance traveled. When something out of the
ordinary happens, he is alerted to the fact by a light
on the dashboard, or something similar. Without this
information, he risks damaging the engine or being
stranded with no fuel.
A computer can supply a lot of information that is
just as important for its continued and smooth
operation. There are a lot of tools available to gather
and display this information. One such tool is
gkrellm, an unobtrusive little application that sits on
your desktop providing continuously updated
information about whatever you want. It uses very
little of the system's resources, is easy to configure
and is in the PCLinuxOS repositories.
On first run, the default setup is placed on the
desktop and a one­time only pop up window
explains how to enter the configuration dialog.

Gkrellm appears as a set of stacked monitors, one
on top of the other, and this stack can be as tall or
as short as you like. The default theme is rather

uninspiring, at least to my eyes. Fortunately, a
package named gkrellm­themes is in the
PCLinuxOS repositories which provides almost 200
alternatives to be as discrete, funky or practical as
you want. You can, of course, always make your
own themes if you are the creative type. More
information is available at the gkrellm­website and
here. I prefer a theme that is easy to read, such as
photon, but you may prefer a theme that blends in
with your desktop.

Default Photon

To start configuring gkrellm, right click on the top
frame of gkrellm and you will be greeted by a
relatively large dialog that enables you to do all of
your changes in one place. On the left is a list of
sections and on the right a tabbed interface with lots
of buttons to check, boxes to enter information into
and other stuff to change as you will. The last tab on
each page is named info, and this is where you find
out which buttons to check and what to type into the
boxes. All of this is, for the most part, fairly intuitive.
But one or two things might need further
explanation, so I will run through a few of them to
get you started.
The first section, General, sets the properties of the
gkrellm window, not the monitors. If you want the
application to appear on all of the virtual desktops,
you check 'set sticky state'. As you probably don't
want it cluttering up your panel or pager, you might
want to also check those relative boxes. Anything
else here? Well I always check 'remember screen
position...' so that I know where to look.
Why this is important can be shown this way: drag
gkrellm to one of the screen edges and middle click

Now you ...And now
see it... you don't
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on one of the vertical bars. It slides shut to just a few
pixels wide. Now the panel is not so obvious, but it is
still monitoring your system, and any alarms or
warnings that you have set will still be triggered
(more on that later). If middle click doesn't work for
you or you don't have a middle button, just click the
left and right buttons simultaneously.
The next section, Builtins, is where most of the
action takes place. Open it up by clicking on the little
triangle at the side of the word builtins. In the default
layout, the first builtin is Sensors, and there you will
find all of the sensors that the system has
recognized. Check the ones that you want to
monitor, and if you want to change the label for that
sensor, then just click on the label and type in your
preference. When you click on a sensor that you
have enabled, the Alerts button becomes active.
Clicking on the button brings up a new dialog. As an
example, if you have highlighted the CPU
temperature sensor and then clicked alerts, you can
set a warning when the CPU temperature is getting
too high. After a couple of days using gkrellm, you'll
know what is the norm. My CPU typically operates
around 40°C, so I set a warning of 70°C and an
alarm at 80°C. What happens then is that the
sensors flash amber for a warning and red for an
alarm (it looks a bit like red and yellow jelly beans).

This is fine, but what if you have closed gkrellm to
minimum width with a middle click on the vertical
bar? You can't see the jelly beans and your CPU is
cooking. This is where the rest of the alerts dialog
helps. You can have some visual or audio event

triggered once or repeatedly. I use the following two
commands in those boxes:
zenity ­­info ­­text=”CPU is gettinghot and bothered”
zenity ­­warning ­­text=”CPUoverheating – Investigate!”
I then will then get a nice little messagebox pop up
on the screen when disaster is about to strike. You
can check that it works by setting the trigger value to
just above its current value, and then run a bunch of
heavy duty apps to trigger the alert.

The next builtin is the clock, which manages both
the clock and the calendar. Here you can choose to
display either, neither or both, and change the

display to set an hourly and/or quarter­hourly chime.
You can also set a launch command. This is a
feature common to many of the builtins. Click on the
monitor to launch your chosen command, e.g., enter
the name of your organizer application in the
calendar command box to launch the application
with a single click on the calendar.
Next up is CPU. There isn't much to do here, but if
you have a multi­core processor or multiple
processors, you can display them separately, as a
composite or even have both types of display. This
allows you to see at a glance just how much work
your processor has to do. Does it seem right or is
there something eating up CPU cycles?
Proc is probably of more use on servers, or for
system administrators, but it can give the stand­
alone user an idea of system load.
Note: If you notice that there is more than one user
declared on the proc monitor, don't panic. Your
system isn't being hacked. You probably have a
terminal open somewhere which counts as an extra
login.
The Disk builtin allows you to monitor data
throughput for either read, write or both, on each
disk and/or partition on the system. If you use solid
state drives, then you should use this, as those
drives currently have a limited number of write
cycles and an uncaring process. Repeatedly writing
small amounts of data can shorten the life of the
drive.
Internet allows you to monitor port accesses, which
you might well be interested in if you are running a
web server or ftp server, or perhaps you would like
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to know if you are receiving unwanted attention.
Ports can be monitored individually or as a range.
Net shows network activity and is particularly useful
if you are on a dial­up or monitored bandwidth
connection. There is an option to enable a timer
button with optional start and stop commands so
that you can see at a glance your time on line. The
chart shows current throughput and speed, and
hovering the mouse over the chart brings up a tiny
button. Clicking this brings up a statistics dialog
showing daily, weekly and monthly statistics for
received, transmitted and total data for the time
period. This is a boon for those on restricted
bandwidth, But be aware that if you use other
computers, or if you dual/multi­boot, these totals
apply only for the operating system on this machine.
Memory offers monitoring of both RAM and swap
memory, allows you to set up alerts and to launch a
command when clicking on the monitor. There is an
option to 'show three memory krells.' A krell is the
small left­right moving pointer, one for each of the
reported memory values, but in most cases, with
current amounts of installed RAM, these values are
so close together that this option is almost useless.
File System is a really useful builtin, but requires a
little bit of work setting things up in order to get the
most out of it. Here you add partitions or storage
devices that you want to monitor and control. For
each device, you need to add a label for the monitor
and a mount point. You then get a meter with a
capacity krell (slider), and clicking on the meter
toggles a scrolling display of usage, free space etc.

In the screen­shot, we have 1 box for the label and 1
for the mount point. Dropping down the mount point
box will give a list of those file systems that it knows
about, and you can select one from there. Give it
any unique label you fancy. At the bottom of the
dialog are the beginnings of two lists of devices
waiting to be populated. A device can be primary or
secondary. A primary device is one that is always
available, like the root directory of the system and
the home directory. A secondary device is one that
gets mounted as required and can be hidden from
view when not required, such as external drives and
CDROMs.
Select a partition to monitor and label it, and decide
if this is to be a primary or secondary device. If
secondary, then click the secondary button. If you
want it to be automatically shown when mounted,
then click that button also, then click new. This will
create the basic monitor for that device.

The system knows how to mount a device if it is
listed in a file in the /etc directory named fstab,
which you need administrator privileges to edit, but
not to view. Each line of this file describes the
information to mount one device. It contains such
information as the device name as known by the
system, the mount point where the contents can be
found when mounted, the type of file system on the
device and any special options required to mount it.
The options part is quite often 'defaults'. This is fine,
but has the disadvantage of only allowing root to do
the mounting and unmounting.
If you have a partition where you keep all your data
that you don't want in your home folder and mounted
at /mnt/data, then it would be good if you could
mount and unmount it at will. If it is unmounted, you
can't accidentally delete or overwrite valuable files.
To be able to do this, edit the /etc/fstab file as root
(make a backup copy somewhere), and locate the
line for the partition that you want to control. Change
the word defaults to users,noauto,defaults – no
spaces and separated by commas. What this does
is to allow ordinary users to mount and unmount the
file system, not automatically mount the file system
at boot time and leave the rest of the options at their
default settings. Save the file. If you are not sure
how to do this without fear of making the system
unusable, then please get some more
knowledgeable assistance.
Go back to the file system configuration dialog and
check the 'Enable /etc/fstab mounting' box. The
'New' button is now labeled 'Apply.' Click on that.
You will now have a button on the right side of the
'data' monitor which you can use to mount and
unmount the device. If the device is unmounted and
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not visible, moving the mouse wheel while over one
of the visible devices will show hidden devices.
Alternatively, move the mouse to the topmost file
system monitor, and a button will appear which can
be used to show or hide unmounted devices. You
can also provide mount and umount commands in
the boxes provided for devices not listed in fstab.
But you must, of course, have permissions to do
this, perhaps by editing the sudoers file. But that is
another tutorial for another day.
Another nice touch is to be able to control ejectable
media. Although most systems nowadays can
automatically detect and mount removable media,
such as CDROMs and thumb drives, it is nice to be
able to keep a measure of control, particularly for
devices such as CDROMs, so that you know exactly
when and where they are mounted. A line like this in
your fstab file will allow you to mount the CDROM
(the first CDROM on the system, if you have more
than one) in the folder /media/cdrom, providing of
course that the folder exists:
/dev/sr0 /media/cdrom iso9660users,noauto,ro, 0 0
If you now fill out the dialog like this:

You will now be able to mount and unmount your
cdrom drive at will. And with the Ejectable box ticked
when the drive is unmounted, moving the mouse
over the mount/unmount button will cause another
small button to appear, which you can click to open
the tray. If the drive is empty, then clicking the
mount/unmount button will open the tray.
The order of the drives in the list can be changed by
simply click­dragging them to a new position.
It is possible to use the file system builtin to control
the mounting of both nfs and smb network shares,
but you must remember to umount the share before
powering down the remote machine, or otherwise
breaking the network connection. If you don't, you
may face problems. The 'show if mounted' box is
useful here, and even if the device or share is
mounted or unmounted by other means, the current
status is always reflected by the gkrellm file system
builtin.
The mail builtin allows you to check local and
remote mail, and to launch mail reader and mail
check applications. Personally, I am more than
satisfied with the abilities of thunderbird and
evolution to handle my mail, but if you want
something different, then this may be worth checking
out.
If you use a laptop, then the Battery builtin is for
you. It can display percentage charge, time
remaining, time to charge and charge status. You
also have the option to set alerts, or to run a
command of your choice when you click on the
meter.

The Uptime builtin displays the time since last
reboot, enables you to launch a command when you
click on the meter and to display a tool tip which you
enter into the comment box.
The section after builtins is Plugins, and if you didn't
install any, then this section will be empty. But there
are quite a few of them available in the PCLinuxOS
repository. Search for gkrellm. They cover additional
functionality and range over a host of different
subjects, some of them being of more use than
others. I don't have a use for a sun or moon clock,
but the weather plugin is particularly good, giving
basic info, changeable by right clicking the meter, or
a full report if you hover the mouse pointer for a
second or two.
There are enough options to cover all bases, music
control with xmms, screen shots, timers, stock
tickers, and even a SETI@home progress checker.
Use as little or as much as you like.
After the plugins section comes themes, and if you
installed the themes package from the repository,
then you may well be spoiled for choice. No further
explanation is required.
Finally, there is the gkrellm­server package.
Installing this will start a daemon running, which can
be used by a remote version of gkrellm to monitor
conditions on the daemon­running machine. If you
have a main computer which you leave running for
long periods and use it to remotely access
resources, perhaps as a file or printer server or for
media streaming, then installing gkrellm­server onto
that computer allows you to remotely see what is
happening very easily. Suppose that the server
computer has a hostname of home_server and is
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connected to the network with an IP address of
192.168.1.2. To remotely monitor the server, run a
terminal command like this:
gkrellm ­s home_server
or
gkrellm ­s 192.168.1.2
You can create a desktop shortcut to execute this if
you don't want to open a terminal.
The instance of gkrellm that appears will show
information about the remote server.
There are some limitations. File system mounting is
not supported, and not all plugins are client­server
enabled. But overall, this is still a very worthwhile
tool.
What you display and how you choose to display it is
your choice – and you certainly have plenty of that!

Screenshot ShowcaseScreenshot Showcase
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Forum Foibles: PCLinuxOS Sandbox BarForum Foibles: PCLinuxOS Sandbox Bar

OPEN 24/7

You'll find us in the PCLinuxOS bar, where we meet,
drink a beer or two and have some fun. Enjoy your
stay & have fun. coffeetime
and free beer, too! tuxfriend
I'd send some beer over, but i can't figure the smile
source. consider yourself in possession of a couple
of barrels of the stuff. cheers. jaydot
This brings up the question, would someone leave
the computer and go buy some beer, or just stick
with the Jack. sixthwheel
P.S. I din't spill no beer getting here either. Linuxera
Go to the fridge and get yourself a beer – you
deserve it!!! longtom
Hmnn is there open source beer? nerdful1
Mmm­mm polish sausage and polish beer. Neal
I would never drink alcohol. A little wine and or an
occasional beer is actually good for your health. And
it might even improve your social life. ongoto
Proves the point that some people look better having
a can of beer in front of their face. tuxfriend
Great work, I owe you a beer Agust
Just what are you going to do to work off all the beer,
potato chips, beer, nachos, beer, peanuts, beer that
you consumed while watching the World Cup?
ms_meme

Look, there's two things in life I'm patriotic about,
football and beer. NLite
Heck... I'd buy ya a beer or ten. What do you say?
MGBguy
One Bourbon, One Scotch, One Beer weirdwolf
Texstar is the lead dev. I owe you a beer my friend !!
E.M.G.
Thank you Tex. It WOOOORKED!!! I owe you
another beer. Riki
I'm with you! Let's have a beer longtom
Make sure you remove all empty beer bottles laying
in the foot­wells. Chuck Chunder
One of your friends accidentally spilled his beer on
the back of your monitor while he was watching the
rotating cube. Texstar
Don't worry, I onlly drink root (su) beer critter

I went to the Beer Store on Thursday (before the
long weekend), and they're systems were down
briefly. pags
You know your computer's female, when it starts
giving you Grief. If it's a male and acting sluggish, it's
smelt the beer. coolbreeze
A KDE4 Club could bring back memories, windows
times memories, when we sat with a beer talking
about the last time the OS crashed. T6
I really wanted a stiff Scotch, but it was too early in
the day. djohnston
This is where I do indeed fill the bathtub, replace the
scotch with a nice Merlot or Pinotage and get myself
nice and heated (and sometimes defrosted).
longtom
When I drink too much caffeine I sometimes
compensate this by drinking some whiskey or vodka.
uncleV
You need help making those cookies. First you need
two bottles of whiskey, not one. Neal
I don't know, you could throw in a few blonds and
some Tennessee sippin' whiskey. BubbaBlues
Tequila, whiskey, and a good wife ­ not necessarily
in that order. ElCuervo
She was only a whiskey maker, but he loved her still.
MeeMaw
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That Mexican Tequila is so frickin' smooth...like
drinking Kool­Aid...but wait for the punch.
Sammy2fish
I don't drink beer but I can make an exception if the
rest drink tequila. Margaritas and other strange mix
lovers please don't apply. Salud. Crow

Hip Hip HOORAY Hip Hip HOORAY!
Hip Hip oops I spilled my beer
If you cannot cheer without spilling your beer
Pull up a chair and park your butt there
I know I can cheer without spilling my beer
So lets stay buds and share some suds
My thought was for you to not spill your brew
Join me at table and keep the thing stable
Just sit nearby and swat that fly
Who stole my beer while I was sitting here
Here have another and we'll soon discover
The reason that beer brings us this cheer
Hip Hip HOORAY I'll say to this day
To friends who knew they'd have fun sharing brew
So pass it along to friends that belong
PCLinuxOS many friends we possess
Sharing is fun so long as we don't run
Out of good brew for this thirsty crew
Neal and Rudge

Am I missing something, am on my 7th beer. They
call me Buzz for a reason. Just wondering. Have fun
all. buzz263
I brewed beer as a hobby several years ago too,
mine was labeled "Monkey Butt" ff103
Here, hold my beer. grnich
I need at least 10 beers to understand this post T6
I agree tho it took me a long time to realize. I was
more worried about free speech than I was about
free beer. Speaking of which, menotu, it's your
shout. F.Luent
Now ... I have good cold Beer here. Come and let's
drink it. uncleV
However, we've got a lot of beer for free. dubigrasu
Sorry, no Bud Light. Can't stand beer in any form. As
to spreading love around, I'm a happily unmarried
straight man, but don't necessarily require the
straight part from my partners, just that they have
bumps in the right places, and no hangy down parts.
old_polack
It's kind of like doing a bunch of tequila shots and
running across a freeway.
GuypronouncedGuynotGuy
There's a bucket over in ~~~~~~~~~~~~> that
corner whenever you start feeling ill. Tequila seems
to run like water around these parts. Linuxera

May the best team win. This Sunday fried chicken
and tequila (strange combination ) for the game.
Crow
I have a 500 GB HD that my wife gave me for
Christmas and a special bottle of tequila just waiting
that day. Crow
If at any time I start to mix tequila then "head in
toilet" or the "passed out" options may become real
but you never know. if you like Tequila you're
welcome any saturday to my home. My medicine,
my medicine.... a tequila at least. Crow
Scotch and coffee pour it right in
Don't stop now.....I'll tell you whin
Thanks a lot.....now I feel so HOT
Fill the bathtub right to the brim
Gonna soak my every limb
Hits the spot.....do I feel HOT
Forget that Irish whiskey
It will give you a chill
Just give me some of my favorite rum
And be careful not to spill
All I need is ten little sips
You bring the coffee I'll bring the chips
Go put on the pot! Let's get HOT!

ms_meme
Aw gawd, ms_meme ... you are the tequila on my
sunrise. Archie
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MP3

OGG

What good is sitting alone in your room Come to the forum and play
Live is a kernel of fun old chum We're going to have a soiree

Lay down your troubles forget that old mouse Have fun before you get too old
Life is a bin of fun old chum That's what I've been told

Come read the jokes from all the folks
Hear meme sing her songs so funny
She won't charge you any money

Sign right in and meet all the crew Windows losers won't be turned away
Life is a bash of fun old chum Come now don't delay

Come on and smile and laugh a while
Meet new friends start celebrating
Right this way your threads are waiting

PCLOS is all that you need We'll put it on your tab
You'll have lots of fun old chum Come to the forum It's FAB

http://www.pclosmag.com/html/Issues/201012/files/cometotheforum.ogg
http://www.pclosmag.com/html/Issues/201012/files/cometotheforum.mp3
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by Paul Arnote (parnote)

As we've mentioned before, one of the things that is
most appealing about e17 is the ability to tweak and
tune the desktop to your heart's content. With just
the addition of a few modules and a few gadgets,
you can have the desktop of your dreams.
What may not be apparent is that you can tweak and
tune your e17 down to how each individual desktop
appears. You can even pick a different wallpaper for
each of your virtual desktops, a KDE 3.5.10 feature
that has been lost (or become more difficult) under
KDE 4. Plus, each and every shelf and gadget you
add to your screen can also be displayed on every
desktop, or only one desktop that you select. Try
doing that with KDE 4's widgets.

Applying Different Themes
Probably one of the things you will want to
eventually do is apply a different theme. Under e17,
it's very easy to apply new themes to your desktop.
First, you will want to install the themes by Agust
from Synaptic. Simply search for "agust" in Synaptic,
and you will find two packages in the PCLinuxOS
repository containing the e17 themes for
PCLinuxOS.
Next, from the e17 main menu, select Settings >
Theme. You will see the dialog below.

Select the theme you want to use, then select Apply,
then Close. The settings under the "Advanced"
button will be covered in more detail later, in a
separate article on how to make your own e17
themes.

Different Desktop Wallpapers
It's actually quite easy to define a different wallpaper
for each one of your virtual desktops.

First, from the main e17 menu, select Desktops >
Virtual > Set Virtual Desktops.

Next, you will get the Virtual Desktops Settings
dialog window. First, the sliders below and to the
right of the desktops display will allow you to
configure how many virtual desktops you want,
along with the configuration you want to display
them in.

e17: Beginner Desktop Tweakse17: Beginner Desktop Tweaks
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Initially, you will see the same wallpaper displayed
on all of your desktops. If you click on each of the
images displayed, you will be presented with the
dialog box shown above. In the "Name" field, you
can give that virtual desktop a name. By selecting
the "Set" button below the image, you can select the
wallpaper to display on that particular virtual
desktop. Repeat this procedure for each of your
virtual desktops that you want to have a custom
wallpaper displayed on. On my computer, I elected
to retain the wallpaper of the e17 theme that I
installed, and to change the wallpaper on the other
three desktop backgrounds.

By selecting the "Advanced" button in the first dialog,
you will be presented with the dialog box above.
Notice that there is now a button, labeled "Basic," in
the place previously occupied by the "Advanced"
button, to easily allow you to switch back and forth
between the basic and advanced settings.

Also notice the presence of tabs across the upper
portion of the dialog box. Besides the first tab,
"Desktops," the other tabs are labeled "Desktop
Mouse Flip," and "Flip Animation." The "Desktop
Mouse Flip" allows you to set if you want any
animation when you drag a window to the desktop
edge and if you can drag that window to another

virtual desktop. The "Flip Animation" allows you to
set what type of animation you want to use when
you activate the animation by dragging a window to
the virtual desktop screen edge.

Stick a launcher up on a shelf!
We'll talk more in depth about setting up
shelves in a separate article, but this is also
a desktop tweak that you may want to
employ now. Specifically, I set up a new
shelf to act primarily as a separate
application launcher, and to monitor CPU
speed.
At the top of the shelf, I placed the CPU
Speed gadget. Immediately below that, I
placed a second instance of the IBar
gadget.
There is
already one
IBar gadget

in my bottom shelf.
But I wanted another
instance of it to hold
other applications I
commonly use. In my
case, those
applications are, from
top to bottom Gimp,
DeaDBeeF, File
Roller, Gcalctool
Calculator and
Leafpad.

e17: Beginner Desktop Tweaks
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When you first add a second instance of IBar, the
settings for the other IBar will automatically be
displayed. But you can easily set up the second IBar
to display a completely different set of applications to
launch. Right click on the second IBar, select
"Gadget IBar," then "Settings." You will then see the
window above displayed. Select the "Add" button,
and provide the name of the new source file you
want to use for the second IBar. In my case, I called
it "oftused."
Towards the bottom half of the window, you can
determine what information is displayed. Select
"Apply," then "Close." You may have to do a bit of
cleanup of the second IBar, deleting items you don't
want and inserting items you do want.
To delete
unwanted items
from the second
IBar, right click the
individual icons
you want to
remove from the
IBar, then select
the "Icon
<Program Name>"
entry, then
"Remove." To add
items to the
second IBar, simply right click the IBar, and select
"Gadget IBar," then "Contents." By default, the
"Selection" tab is highlighted. Listed below that are
all the applications installed on your system that
have corresponding .desktop files. Choose the one
that you want, select the "Add" button, then select
"Apply." Repeat the procedure for each application
you want to add to your second IBar.

After you are finished selecting the applications you
want to display in your second IBar, switch to the
"Order" tab, and set the order you want your
applications to appear in. Select the "Apply" button,
then the "Close" button. Your second (new) IBar
should now be filled up with the applications you
selected.
Trust me. It's a lot easier than it sounds.

Placing Icons On The Desktop
I'm not a huge fan of having a lot of icons on my
desktop. It's too reminiscent of the desktop icon
mess I used to have in Windows, where EVERY
application wanted to install itself to your Windows
desktop. But then, I also know that there are
probably just as many PCLinuxOS users who like
having icons on their desktop as there are those
who do not.
Of course, one way is to follow the steps above to
create a launcher using IBar, as outlined above. But
if you really want icons directly on your desktop,
there is a way to do that as well.
Open your file manager (Dolphin in the full version,
PCManFM in the light version), and travel over to
/usr/share/applications. There, you will find all the
.desktop files for the applications installed on your
computer. Go down the list until you find the
application listed that you want to add. Right click on
the file, and select copy. Go back to your /home
directory, and paste the .desktop file you just copied
into your /Desktop folder.

Voila! Now the icon to the application you selected
should immediately appear on your e17 desktop.

More to come
Like I mentioned before, there are more tweaks for
e17 coming. We have articles in the pipeline
covering how to make your own custom e17 themes,
how to customize your bottom shelf, how to set up
and use a custom shelf, and a rundown of the
available modules and gadgets. All of these articles
will help you further tweak and tune your Linux e17
desktop in many ways that you never could before.
That is one of the beautiful things about e17, and
one you should exploit.

e17: Beginner Desktop Tweaks
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Alternate OS: Kolibri, Part 1Alternate OS: Kolibri, Part 1
by djohnston
MenuetOS was originally written in May 2000 by
Ville Turjanmaa. Menuet began as a 32­bit OS,
written completely in assembly language. It fit on a
single floppy, along with more applications that came
as standard with the OS. It featured protection for
the memory and code, had a GUI running at 16.7
million colors, sound at 44.1 khz stereo, and a low
level API. By January of 2005, Ville announced work
on a 64­bit version. In June 2005, he released the
first 64­bit OS. It still fit on a single floppy. By March
2006, he announced an end to the 32­bit code, due
to "open source fighting". A 32­bit development fork
had developed, which resulted in KolibriOS. The first
release of Kolibri was announced in February of
2007. It still fit on a single floppy, had NTFS read
support, an AC'97 music player, drivers for
Fat12/16/32/ISO9660
filesystems, a TCP/IP
stack, network
applications including
ftp/http/mp3 servers,
a GUI with resolutions
up to 1280x1024 and
16 million colours,
and over 150
programs (text editor,
paint editor, file
managers, games,
etc.) A screenshot of
an early version of
MenuetOS is shown
at left.
I should note that
MenuetOS has since
continued limited

development on the 32­bit version. I did install it in
VirtualBox, but didn't use it long because I could not
maintain control of the virtual mouse. Menuet's
home page is at http://www.menuetos.net/index.htm,
where you will find links to both the 32­bit and 64­bit
files.
I began the installation for this article by going to
Kolibri's home page at http://www.kolibrios.org/. On
the page, you will find links to a bootable floppy disk
image, a live CD image, source code for the kernel,
applications and libraries, and a software
development kit. I downloaded both a floppy image
and a live CD image. Although I had not run Kolibri
before, I had run Menuet on real hardware, from a
small 32 MB partition on my hard drive. To do so, I
installed MSDOS, then installed Menuet, and
modified the autoexec.bat file to automatically load

Menuet. I wanted
to run Kolibri
"natively" in
Virtualbox, if at all
possible. I started
researching at their
wiki at
http://wiki.kolibrios.
org/wiki/Main_Pag
e, and jumped to
the FAQ link. In the
"How do I boot
Kolibri from my
Harddisk" section
are instructions for
dual­booting with
Windows and
booting from
GRUB. In the
booting from

GRUB instructions, we find:
If you want to boot KoOS directly with grub, you
need to do this:

* get and install the syslinux package
* copy /usr/lib/syslinux/memdisk to /boot
* point your config "root"­entry to your FAT or

NTFS­partition, where the image resides, and write
the kernel­entry with (hd0,0)/boot/memdisk or where
ever your linux partition is.

* add these lines to your grub.conf:
Code:
label KoOS
root (hd0,0) # edit this to your correct partition, given
example is hda1
kernel /boot/memdisk
initrd /boot/kolibri.img

* reboot and enjoy
BTW, there is one limitation in this method: The
kernel cannot save its boot settings :(
NOTE: I found that it is possible to save the boot
settings.
The syslinux package comes pre­installed on
PCLinuxOS. The kolibri.img file is the resulting
floppy disk image, after unzipping the downloaded
file. For GRUB to boot, I would need the stage1,
stage2, and the fat_stage1_5 files. I copied
/usr/lib/syslinux/memdisk, kolibri.img, and the
/boot/grub stage files needed to a new directory. I
then created a new VirtualBox virtual machine with a
FAT16 hard drive and the PCLinuxOS ZenMini live
CD as the boot drive. Starting the VM for the first

http://wiki.kolibrios.org/wiki/Main_Page
http://www.kolibrios.org/
http://www.menuetos.net/index.htm
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time, and booting from the ZenMini CD, I started
PCC's diskdrake in order to partition and format the
hard drive, since this cannot be done from the Kolibri
live CD. I saved the changes and shut down the VM.

The next step was to copy all the required files from
my hard drive to the VM's FAT16 hard drive. I could
have used a shared folder to do this, but I chose
another method. Using AcetoneISO, I created an iso
file of the folder containing the required files for the
VM. (See above screenshot.) I then booted the
Kolibri VM from the ZenMini live CD again, and
chose the Copy to RAM boot option. This would
leave VirtualBox's CD slot open to mount the iso I
had created from a folder. After booting, I
unmounted the ZenMini iso, then mounted the iso
containing the files required for Kolibri. Using Zen's
Nautilus file manager, I created a /boot directory on
the FAT16 hard drive. Changing to the new directory,
I copied kolibri.img and memdisk from the iso to the
boot directory. Then I created a /boot/grub directory
and changed into it. Next, I copied stage1,
fat_stage1_5, and stage2 files to the /boot/grub

directory. Last, I created the text file menu.lst with
the following contents:
timeout 5
label KolibriOS
root (hd0,0)
kernel /boot/memdisk
initrd /boot/kolibri.img
I could have left out the timer, but I like being able to
troubleshoot GRUB when necessary. The file copies
and creation of menu.lst being done, it was now time
to make the hard drive bootable. I shut down the
VM. I booted once more from the ZenMini live CD,
this time pressing the escape key at the GRUB
menu, and answering OK to leave the graphical boot
menu. I then pressed c to get to the GRUB prompt.
The next set of commands were issued from the
prompt to setup Kolibri to run and to create a
bootable hard drive.
root (hd0,0)
kernel /boot/memdisk
initrd /boot/kolibri.img
setup (hd0)
After verifying the results were
successful, I issued the halt
command to shut down the VM
session. Then I detached all
the iso images from the Kolibri
VM, leaving only the hard drive
to boot from. Finally, I booted
Kolibri from the FAT16 hard
drive. The GRUB boot screen
is shown at right.

Without intervention, Kolibri will boot in 5 seconds to
the screen shown below.

Note that the default videomode for setting [a] is
1024x768x24. It now defaults to the current values
because I changed it and saved the kernel boot
settings after starting the Kolibri VM. By pressing a

at this screen,
you can select
the desired
video mode.
Item [c] is to
change the
vertical refresh
rate. It defaults
to 60 hz. After
pressing the
Enter key, we
are presented
with the Kolibri
desktop (next
page.)

Alternate OS: Kolibri, Part 1
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In the next installment, we will take a look at the
applications included.

Screenshot ShowcaseScreenshot Showcase

Alternate OS: Kolibri, Part 1

Posted by ramchu, November 24, 2010, running KDE4.

http://pclinuxos.com/?page_id=213
http://www.tuxmachines.org
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by Paul Arnote (parnote)
Sometimes, when browsing the web, you need more
than one way to copy a link. There may be times
when you need a regular HTML link, other times
when you want to copy that link in the proper format
for direct insertion into forums that use BBCode (like
the PCLinuxOS forum), and yet other times when
you might want to copy that link in the proper format
for insertion into a Wiki.

Enter CoLT, a Firefox extension that's been around
since Firefox 1.5. Currently, CoLT is up to version
2.5.0. It is written and maintained by Jonah Bishop,
who works by day as a System X tools developer for
IBM, and who also has created another Firefox Add­
on, called Googlebar Lite. It can be downloaded
from the Firefox Add­ons page, or from Jonah
Bishop's blog site.
CoLT can also copy links in a format that makes
them easy to insert into *.txt files and word
processing files. In fact, as you're about to find out,
CoLT can be easily extended and customized to
assist with the copying of URLs into other formats.

Configuration

From the Firefox Add­ons dialog, select the
"Preferences" button, and you will be presented with
the following dialog:

At the top of the dialog box, you can select the top
level menus you want to display when you right­click
your mouse on a link. Under the "Custom Format
Menu Items" section of the dialog box, you can see
the different custom formats that CoLT is preset for
copying URLs to your clipboard.
But suppose you want a custom format for your URL
that is not listed. Click on the "Add..." button, and
you will be presented with the dialog box (top of next
column).
You are now given an opportunity to define your new
menu entry, and extend CoLT's functionality. In the
top text entry box, enter the text that you want to use
to represent your new menu entry. In the second text

entry box, labeled "Format," enter the custom
formatting you want to use for your new menu entry.
At the bottom of the dialog box is a list of variables
you may use to define your custom formats.
The dialog boxes pictured above, by the way,
represent the default settings you get when you
install CoLT.

What you get
Since CoLT comes pre­configured, you really don't
have to set up your "Preferences." Instead, simply
right­click your mouse over a link, and you will get
this:

Firefox Add-ons: CoLTFirefox Add-ons: CoLT

https://addons.mozilla.org/en-US/firefox/addon/1812/
http://www.borngeek.com/firefox/colt/
http://www.borngeek.com/firefox/colt/
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By selecting the "Copy Link Text and Location As »"
menu item, you will get your other options for the
formats that are set up in CoLT, like this:

It's that easy!

Conclusion
CoLT has been one of my best, most favorite Firefox
add­ons for a very long time. It has saved me many
headaches and a lot of time when I need to paste

links into Wikis, the PCLinuxOS forum, or when I am
doing the layout of the magazine articles that have
active links within them. What's best is that CoLT is
one of those very small Firefox add­ons that stays
out of the way until it is needed.

Screenshot ShowcaseScreenshot Showcase

Firefox Add­ons: CoLT

Posted by ruel24, November 12, 2010, running KDE4.
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It's beginning to look a lot like Linux
Everywhere you go

Take a look around the net
And what you see I bet

Is PCLOS all aglow

It's beginning to look a lot like Linux
For it folks are starting to shop
And the prettiest sight will be

The Linux that you see
On your own desktop

OGG

MP3

ms_meme's Nook:It's Beginning To Look A Lot Like Linux
ms_meme's Nook:It's Beginning To Look A Lot Like Linux

http://www.pclosmag.com/html/Issues/201012/files/itsbeginingtolooklikelinux.ogg
http://www.pclosmag.com/html/Issues/201012/files/itsbeginingtolooklikelinux.mp3
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by Paul Arnote (parnote)

Last year, I published a holiday gift guide in The
NEW PCLinuxOS Magazine, featuring affordable
holiday gift ideas for your favorite PCLinuxOS user.
So, I decided to give it another go this year. All
prices are in U.S. dollars. I've only featured items at
their regular prices, and have not knowingly featured
any sale prices (since the sale will likely be over
before the publication date of this article). Seeing
how this is the month of December, chances are
good that you will be able to find many of the items
on sale, at a lower price, the closer we get to the
winter holidays.

Rosewill RTK­045 45 Piece Premium Computer
Tool Kit

Newegg.com, $14.99
This computer tool kit comes with most things you
will need to do repairs on your PC. It features a
ratcheting screw driver handle, a wide assortment of

screwdriver bits for most screw types, needle nose
pliers, a wire stripper, tweezers, hex key wrenches, a
collection of spare screws and nuts, the ever­
important grounding strap, and a nice zipper case to
store it all in.

SYBA SY­IPO20010 USB Car Charger

Newegg.com, $4.99
If you need a way to charge your MP3 player, or
perhaps your iPhone, Blackberry, Droid or other cell
phone while you're driving down the street, this
inexpensive accessory may be just what you are
looking for. Simply plug it into the accessory plug in
your vehicle (from what I hear, it's no longer
politically correct to call it a cigarette lighter plug),
and plug a standard USB cord into the back end of
the charger that has the proper sized USB plug for
your device on the other end. It also features
automatic shutoff overcharge protection. 12­24V
input, 5V 450­500 mA output.

Rosewill RUA­F1 Stylish Mini Personal Desk Fan

Newegg, $6.99
Featuring soft, nylon twin blades, this USB powered
personal desk fan is just the answer to create a
gentle breeze while you work at your computer
workstation or laptop. The blades are mounted at the
end of a bendable goose neck, allowing you the
ability to direct the airflow wherever you desire. A
fingertip pushbutton allows you to turn the fan off or
on, without having to unplug the fan's USB
connector.

2nd Annual PCLinuxOS Holiday Gift Guide2nd Annual PCLinuxOS Holiday Gift Guide

http://www.newegg.com/Product/Product.aspx?Item=N82E16899261003
http://www.newegg.com/Product/Product.aspx?Item=N82E16800998126
http://www.newegg.com/Product/Product.aspx?Item=N82E16800996107


35

SYBA PCI 1­Channel CardBus Host Controller
Card Model SY­PCI­PCM

Newegg.com, $16.99
If you are a laptop user (or if you used to have a
laptop), you most likely have an assortment of
PCMCIA or CardBus cards that accompany that
laptop. The problem is that there is no easy way to
use those accessory cards for your laptop on your
desktop system. For some reason, these scaled­
down cards never caught on in the desktop market.
But now, with the addition of this PCI card to your
desktop computer, you can now use those PCMCIA
and CardBus laptop cards on your desktop
computer. I don't know about you, but I'm all for
getting as much mileage as possible out of the
equipment I already have on hand. It prevents me
from spending additional funds on similar cards just
for the desktop computer.

Rosewill NEC 4+1 Port USB2.0 PCI CARD Model
RC­101

Newegg.com, $11.99
If you have some older hardware that you have used
PCLinuxOS to resurrect and give new life to, there is
a good chance that the USB ports on that older
computer are the older USB 1.1 ports, that transfer
data at 1.1 Mbps. While they will work, it's like
waiting for Windows to load. It takes forever. But, if
you have an empty PCI slot in that older desktop,
you can easily upgrade those USB ports to the more
modern USB 2.0 standard, and experience data
transfer rates of up to 480 Mbps.
This card features four (4) external USB ports, and
one internal USB port. This card should be plug­n­
play with your PCLinuxOS system, after a reboot.

Zotac MAG HD­ND01 Intel Atom 330 NVIDIA ION
graphics processor Mini / Booksize Barebone
System

Newegg.com, $279.99
If you're looking for an inexpensive upgrade to
replace an aging computer, the Zotac MAG HD­
ND01 may be just the ticket. Sure, it's not the least
expensive barebones computer system at
Newegg.com, but then this also comes with a 160
GB SATA drive and 2 GB DDR2 800 MHz RAM. The
Zotac features a Intel Atom 330, which is a low­
energy dual core processor, with each core also
being a hyperthreaded core. It also features an
NVIDIA ION graphics processor for the onboard
video, as well as a multi­card reader. There is one
USB 2.0 port on the front, with four additional USB
2.0 ports on the back of the unit.Your Community Projects Forum
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http://www.newegg.com/Product/Product.aspx?Item=N82E16815124021
http://www.newegg.com/Product/Product.aspx?Item=N82E16815166002
http://www.newegg.com/Product/Product.aspx?Item=N82E16856173001
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Besides featuring 10/100/1000 ethernet, the Zotac
also has built in 802.11 n wireless with an Atheros
chipset. It also features 8 channel audio, and a
choice of VGA or HDMI video connections.

Pixxo MA­C1G5 RF Wireless Optical 1600 dpi
2.4GHz RF Wireless Optical Mouse

Newegg.com, $9.99
I know that wireless optical mice are as common
place today as roses on Valentine's Day. I can
personally attest to the quality of this mouse, since I
own one. Besides, it's very affordable, as well. This
mouse is a good size, and its weight gives it a very
nice feeling in your hand. The receiver is very small,
and stores in the bottom of mouse when it's not in
use. The only thing missing from this mouse is a tilt
wheel, but for the price, I don't miss it, and I doubt
you will either.

This mouse sports a very precise resolution (1600
dpi), an automatic "sleep" mode to conserve

batteries, a flashing low battery indicator light, and
tends to be quite miserly with the batteries. It also
has quite a good range for such a small mouse, with
the transmitting distance a healthy eight (8) meters
(about 25 feet). For only two dollars more, you can
also get this mouse in either red or blue.

Kingston 4GB Micro SDHC Flash Card with
microSD/SDHC USB Reader Model
MRG2+SDC4/4GB

Newegg.com, $10.59
I admit it. I'm a flash memory junkie. But this is one
of my all­time favorites. You get a 4 GB
microSD/SDHC memory card, with the slimmest of
USB microSD card readers. With the microSD card
in place, it behaves just like any other USB Flash
Drive, and works well as a Live USB. But the added
benefit is that you can replace the 4 GB microSD
card with the storage card from your cell phone and
transfer files between your cell phone and your
computer simply by plugging it into your computer's
USB port. Plus, the price is hard to beat.

Embark 43041 Neoprene Notebook Slipcase
w/Shoulder Strap ­ Fits up to 15.4" (Black)

Geeks.com, $7.99
This neoprene notebook case will provide plenty of
protection for the notebook computer of any
PCLinuxOS road warrior, protecting it from the
elements. It also features an adjustable shoulder
strap and a front pocket for storage of papers and
media.

19" 720p Widescreen LCD Monitor w/Speakers
(Black)

Geeks.com, $89.99
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In today's tough economy, going "green" makes
sense. So maybe it's time to replace that energy­
sucking, larger­than­a­bus old CRT computer
monitor that you've been using for the last 15 years.
This widescreen 19" LCD monitor would make an
excellent replacement. It has a 1440 x 900 screen
resolution, features a 5 ms response time, a 500:1
contrast ratio and 160 degree horizontal and vertical
viewing angles. It also has built in speakers,
eliminating the need for additional external speakers
– something that will save you desk space,
especially if your desk space is at a premium. Since
it is also wall mountable, you can save even more
desktop real estate.

Ion Audio TTUSB10 USB Turntable/Vinyl Archiver

Geeks.com,$69.99
If you're anything like me, you have a fairly sizable
collection of vinyl records – 45's and albums – that
are just sitting around gathering dust (hopefully, you

have them in their sleeves). Plus, vinyl is making a
comeback among audiophiles. Wouldn't it be nice to
have a way to not only listen to your old collection of
vinyl records, but also a way to convert them to
modern, digital media formats? The Ion Audio USB
Turntable/Vinyl Archiver can save the day, as well as
your old collection of vinyl records. It is reported to
be Linux­compatible: just plug in the USB cable to
one of your computer's USB ports. Included in the
box is even a copy of Audacity (albeit the Windows
version) to perform the audio recording chores.
That's good news for you, since Audacity is already
in the PCLinuxOS repository and easily installed.
The turntable will play your 45 singles and 33 1/3
albums and long play records, and comes ready to
go, complete with a stylus, with minimal setup
required. About the only thing you will have to do is
balance the tone arm, which is a simple task for any
true audiophile.

Roadmaster DHM140 14oz Electronic Travel Cup
Warmer (Silver/Black)

Geeks.com, $5.59

Alright, alright. This really isn't a computer
accessory, but then given the love of coffee among
PCLinuxOS users, you won't go wrong with this gift.
Simply plug one end of the cord into the handle of
the coffee mug, and the other end into the accessory
plug in your vehicle, and you will be enjoying piping
hot beverages wherever you go. There's nothing
quite like enjoying a hot cup of coffee (or tea) while
on your way to your local computer store to pick up
another stack of CDs (you know, for making
PCLinuxOS Live CDs to hand out), without fear that
your beverage will become cold.

ShredderShark SH2807 7­Sheet Cross Cut
Shredder w/Basket

Geeks.com, $17.50
While not technically a computer accessory, no well­
equipped home office or computer den should be
without a decent shredder. After all, you have to
have a secure way to dispose of your paper trail,
which often contains bank account numbers, social
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security numbers, credit card account numbers, and
a myriad of other sensitive, revealing (and potentially
damaging) information. What's best is that this
shredder will also handle CDs, DVDs and credit
cards. And cross cut shredders offer better
protection of your sensitive data than simple straight
cut shredders.

Benwin ARC­EC­21 3­Piece 2.1 Channel
PC/Game Speaker System (Black)

Geeks.com, $17.79
Replace your aging computer speakers with this set
of stylish and affordable 2.1 channel surround sound
speakers. It's hard to fathom the difference in sound
quality that you get with the subwoofer until you give
it a try. With these speakers, your games and music
will gain extra clarity and a deeper, richer sound
quality.

Augen GENTOUCH74 400MHz 256MB 2GB 7"
Touchscreen Tablet Android 1.6 w/Leather
Carrying Case (Black)

Geeks.com, $129.99
Loaded with Google Android 1.6, this tablet is a
take­anywhere, go­anywhere computing device that
is a custom fit for any die­hard computer road
warrior. Complete with 802.11 b/g wireless, this
tablet has 2 GB of built in memory, a 400 MHz ARM
processor, and it accepts memory expansion up to
32 GB via microSD/SDHC memory cards. It comes
with numerous apps from the Google Android apps
store pre­installed, with thousands more available
for download. It also comes with an AC adapter to
charge the built in rechargeable lithium ion battery,
and a leather carrying case. So why spend the
money on a more expensive eBook reader, when
you can have a more functional tablet that will not
only allow you to read your eBooks, but also allow
you to view pictures, play music, play videos and
connect to the internet to check your email or the
PCLinuxOS forum?

A newer model, featuring the Google Android 2.1 OS
and an 800 MHz ARM processor, is also available
for $30 more.

PCLinuxOS Golf Shirt

PCLinuxOS CafePress Store, $19.99
Dress up in style, and spread the word about your
favorite Linux distribution at the same time with this
fashionable golf shirt. It's made of 5.5 oz preshrunk
60/40 cotton/polyester pique material that resists
wrinkles and shrinkage. The PCLinuxOS logo,
emblazoned across the left upper chest is a nice
touch that's hard to miss.
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PCLinuxOS Large Coffee Mug

PCLinuxOS CafePress Store, $15.99
Approved by Neal, this large 15 oz coffee mug will
adorn your desk with style. With a large handle, this
cup measure 4.5" tall and 3.25" wide. It is also
dishwasher and microwave safe. There will be no
question what coffee mug is yours!

PCLinuxOS Mouse Pad

PCLinuxOS CafePress Store, $12.99
Keep your mouse tracking with this rubber­backed,
cloth front mouse pad, emblazoned with the official
PCLinuxOS logo. The mouse pad is machine
washable.

PCLinuxOS White T­Shirt

PCLinuxOS CafePress Store, $18.99
Made of 6.1 oz pre­shrunk cotton, you can wear the
most fashionable t­shirt in the crowd. The
PCLinuxOS logo is proudly displayed across the
front of the shirt.

PCLinuxOS Dark T­Shirt

PCLinuxOS CafePress Store, $22.99
You will be strutting in style with the PCLinuxOS
Dark T­Shirt, available in nine different colors. All
shirts feature the official PCLinuxOS logo
emblazoned across the chest, and are made of 5.6
oz 100% pre­shrunk cotton.
There you have it. Twenty gift ideas that are certain
to tantalize and thrill the PCLinuxOS user on your
gift list. If you purchase any of the PCLinuxOS items
from the PCLinuxOS CafePress Store, a portion of
the proceeds will help support PCLinuxOS. Also, if
none of the gifts listed above are what your favorite
PCLinuxOS user needs or wants, no self­respecting
PCLinuxOS would turn down a $25 donation to
PCLinuxOS made in their name to help support their
favorite Linux distribution. Happy holidays!
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by Gary L. Ratliff Sr. (eronstuc)

This month, we take a look at Tcl/Tk. We learn from
the excellent book, Graphical Applications with Tcl &
Tk, Second Edition, by Eric Foster Johnson, that
Tcl/Tk is often pre­installed with Linux.
To pursue this idea, I queried the versions of Linux
on my main computer to learn if this were true, and if
so, which version was installed: PCLinux 2010 tk
8.6, PCLinux 2009­1 tk 8.6, PCLinux 2007 tk 8.4,
Debian 2.5­26­686 not installed, Debian 2.6.26 amd
64 not installed, openSUSE 11.2 tk 8.5, Ubuntu 9.10
tk 8.4, Ubuntu 10.04 LTS tk 8.4, Mythbuntu 8.04
LTS tk 8.4, Dreamlinux 3.5 tk 8.4, Absolute Linux
(Slackware 13.0.0.0.0) tk 8.5, KNOPPIX 6.2 tk 8.4,
Linux Mint 8 (Helena) tk 8.4, and Mandrivia 2010 tk
8.6.
Tcl (tool command language) was created by John
Ousterhout during the late 1980's. He first developed
the idea in 1987 as he was working in the design of
tools. He began giving the system away, and later
became concerned with the complexities of
developing GUI',s which idea resulted in Tk, or a
graphical toolkit.

Make a Wish
The Tcl/Tk set is comprised of two interpreters. One,
tclsh, is a shell language like bash (or the korn shell
mentioned a few months ago), which only
understands tcl. The other, which allows the
graphical features of tk, which is known as wish.
Often this will include the version of the tk used as

wish80, which is the version covered by the Eric
Foster Johnson book. To illustrate just how easy a
graphical may be created. The ubiquitous “Hello
World” program is presented in tk as follows:
button .a ­text “Hello World!”­command { exit} ; pack .a
These two lines entered into the console, which
appears after you issue the wish command, will
soon create a button which displays the message
“Hello World!,” and which closes when you click on
it. From this humble introduction you can begin to
learn the details of creating and using the various
widgets offered in the tk system.
The book was written about ten years after
Ousterhout first developed the idea of Tcl. And in
800 plus pages the details of using buttons, dialog
windows, canvas widgets and the rest of the items
available are explained and illustrated. The book
also included a CD with all the code and the 8.0
version of wish and a much earlier version on the
CD.
Early in the week, my daughter arrived from a visit to
Nashville, and showed me that my brother had sent
me his old IBM Aptiva computer. This computer had
Windows 95 installed, and soon version 8.0 of wish
and version 8.0 0f tclsh was installed on this older
system. The text concludes with the details of how to
add Tcl into the C language, and also how to design
your own extensions to the language.
As Eric stated early in his book, Tcl development will
continue. Also, several new versions have appeared
since the 8.0 version covered by this text. In an
email to me, he recommends a text by Ousterhout

written in May 2008 as being the best book on the
market which explains the language.

Learn from Demo's
At present, we have the most current version of the
wish and tclsh programs already installed on our
systems. However, so as not to be burdened with
getting a text to type in the examples, I will show you
how to get some powerful demos which will easily
illustrate some of the features of the Tcl/Tk system.
If you enter "tcl/tk downloads" in Google, one of the
sites which will be presented will be for the active
state version:

Computer Languages A to Z: Tcl/TkComputer Languages A to Z: Tcl/Tk
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They have a free community version, and another
which offers full support for serious developers.
Now the free community version is available in many
flavors, as this next page clearly shows.

The version I selected to download and install was
the 8.6.0.0b3 version. This will arrive on your system
in the familiar tar.gz format. Your goal is to install the
system, and for this, you will need to become root in
order to be allowed to have the system create the
directories, into which it will install the system. A
simple script is used to install the system. This is all
done with these steps:

1. Download ActiveTcl8.6.0.0b3.292682­linux­ix86­threaded.tar.gz2. gunzip ActiveTcl8.6.0.0b3....tar.gz3. tar ­xvf ActiveTcl8.6...........tar4. cd ActiveTcl85. ./install.sh
The system will be installed into the directory:/opt/ActiveTcl­8.6
Under this, the bin directory will contain the
interpreters wish 8.6 and tclsh 8.6, and the demos
directory will contain various Tcl scripts. These will
fully show the use of the many widgets and features
of the Tk system.

The key to getting to this set of demos is to enter the
following command into xterm or another terminal
window:
wish8.6 /opt/ActiveTcl­8.6/demos/Tk8.6/widget.tcl
Now you can really save some time by now looking
at your history file and noting the number of this
command. To again launch this system, you will only
enter ! followed by the number history has assigned
to this command. On my PCLinuxOS 2007, the
number assigned to this was 999, while on my more
recently installed 2010 version, it was 108.

I also installed the system to my PCLinuxOS 2007,
which is on another computer in my network. As that
used tk 8.4, I just copied the wish 8.6 files and
tclsh8.6 files into the location of the 8.4 files. Also,
note that you are running the version of wish8.6 and
tclsh8.6 which was pre­installed, and not the Active
State version.

Computer Languages A to Z: Tcl/Tk
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We will conclude this discussion of the demos with
an example of the Rube Goldberg demo. The text
states his quote to the effect that man will find a
complicated means of performing a simple task.
A great example of this complexity is shown every
time TCM (Turner Classic Movies) starts a movie.
You are currently treated to a marble flowing and
looping before the movie ultimately begins. Now in
the Rube Goldberg demo:

The ball drops which lights the match, causing the
weight to fall on the cage door, which releases the
mouse.
I hope you download this version and install it, as
you will really enjoy this one animation. Also, these
demos will allow you to examine the code to learn
how the widgets are set up. All these show just how
easily the Tcl/Tk system makes creating GUI
applications. To learn more and develop your own,

you may wish to pursue the
Tcl/Tk documentation, which
will cover the details of the
newest versions of the system.
Now you may wish to visit the

web site of the author of the text mentioned. When I
pulled this volume off my shelves, I thought that I
had heard the name before. Now, by examining the
covers of the books he has written, we learn that he
has made many contributions to those learning
Linux and open source software. I soon found that I
had also read another of his works called "Teach
Yourself Linux." This, too, was easy to read and
covered the topic completely.

Answers to Mark Szorady's Double Take:
(1) Gift package larger; (2) Woman's hair shorter; (3) Reindeer's
collar bells missing; (4) “Returns” changed to “Service”; (5) “Mrs.”
changed to “Santa”; (6) Glasses stem missing; (7) Reindeer's nose
smaller; (Bonus find! Earring different color)

Computer Languages A to Z: Tcl/Tk
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Game Zone: Hotei's Jewels - RelaxGame Zone: Hotei's Jewels - Relax
by Meemaw
Before discovering that some of our favorite games
worked under wine, I looked for a game like
Bejeweled because I thought it was so fun. I loved
the Linux version Gweled, but I'm always looking for
something new. Hotei's Jewels ­ Relax is another in
the category of "Match 3" games, similar to
Bejeweled or our own Gweled.
From Big Fish Games:
"Hotei is one of the 7 gods of happiness; the happy
god of abundance and good health. Hotei is seen
carrying a large bag over his shoulder that is said to
contain gifts and fortunes for those who believe in
his virtues. Your goal is to connect all 4 parts of the
Magic Island Coin, then go on to find 12 magic coins
(one coin on each island), and bring them to Hotei. If
you can make it back, Hotei's Jewels will be yours!"
I can't get it to run on my Windows computer, but the
Linux version can be downloaded here;
http://linux.softpedia.com/get/GAMES­
ENTERTAINMENT/Puzzle/Hotei­s­Jewels­­Relax­
51461.shtml. All that is necessary is to extract the
files into a folder in your /home. You can just go to
that folder, double click the executable file and it will
run from there. You could also make a menu entry
for the program, but it's not necessary.
This game has a few differences from Bejeweled or
Gweled. The main difference is that you are looking
for the coins in your game board. There will be four
pieces, which will go together to make a full coin.
You will have to match your jewels so that the coin
pieces fall to the bottom of the board. Only when all
four pieces have fallen out the bottom do you go on

to the next board/level. If by chance there are no
more moves on a particular board, the game board
is rearranged so you can proceed.
Getting in your way are a couple of blocks you'll
have to work around. One is a jewel with a lock on it,
which can not be moved, but can only be matched
with two flower jewels. If you can move a flower and
line up two flowers and the lock, it will turn into a
flower, and you can go on and match it normally.
After it turns into a flower it will fall through the board
like any other jewel. The other is a wooden 'box',
which doesn't move, and as far as I know, can't be
matched with anything to get rid of it. You just have
to work around it.

There are ways to proceed through the game in
spite of these hurdles. One jewel is a
multi­colored circle. Matching it with two
of any other identical jewels will get rid of
them. In addition, if you match four rather
than three, you get one of the bombs,
which, when you click on it, destroys all the jewels in
a 3 x 3 area around the bomb you clicked on. Also, if
you match 5 rather than 3 or 4, you get the other
bomb, which destroys all the jewels in both diagonal
directions from itself. Both bombs will destroy the
lock and the box, so you can proceed from there,
too. Also, you can go on and match jewels rather
than exploding the bombs, which in many cases will
help you out. If you want to match three instead of
using a bomb, you can interchange the bomb with a
jewel. Just be sure to click on the jewel FIRST. If you
click on a bomb without another jewel being
selected, the bomb will, of course, explode. If you
click on a bomb and a coin is in the 'blast pattern',
the coin is not destroyed.

Bomb 1 and corresponding 'blast pattern'
<­­ Lock

Box ­­­>

http://www.bigfishgames.com/
http://linux.softpedia.com/get/GAMES-ENTERTAINMENT/Puzzle/Hotei-s-Jewels--Relax-51461.shtml
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Bomb 2 and corresponding 'blast pattern'
The trick in this game is to destroy the correct
jewels to make sure each coin piece falls out the
bottom of the board. Most of the time it's easy, but
I have gotten to the point in each game I've played
where I can't find a move that will line up the

jewels as desired. Usually I just wait until the game
gives me a hint. There is a help screen, but it's not
complete, and I had to figure out how to get rid of
the lock myself. As you progress through the levels,
it gets more difficult. I haven't gotten through the
entire game yet, so I don't know how it ends. It's
great fun and occasionally frustrating! Enjoy!!!

Game Zone: Hotei's Jewels ­ Relax

It's easier than

e=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

http://www.pclinuxos.com
http://www.linfx.com
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Screenshot ShowcaseScreenshot Showcase

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

The NEW
PCLinuxOS
Magazine

Created with
Scribus 1.3.8

Posted by coffeetime, November 8. 2010, running Openbox.

http://twitter.com/iluvpclinuxos
http://www.scribus.net
http://www.linpc.us
http://groups.google.com/group/pclinuxos-beautification-2009
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by Daniel Meiß­Wilhelm (Leiche)

Do you like YouTube? Do you like to downloaded
videos from there?
If you use Firefox with the Flash and Video
Download add­ons, they will store the video as .flv
files on your computer.
You can play it with many players, but I like it even
simpler.
You can convert the audio in whatever application
you like, such as with soundkonverter or ffmpeg on
the command line, but I like it simpler.
I use PCLinuxOS FLV Player and Converter. I wrote
the application to make the whole process as simple
as possible.

To start, click on PC­MENU > Audio > PCLInuxOS
FLV Player and Converter.
To read what it does, click on the About button, and
you will see this:

When you select the Play button, you will be able to
select and play a video. Note that only .flv files will
be listed.

When you select a video, mplayer will play it.
The video will play through to the end. After it has
finished, choose another video to view, and maybe
you can be a Video DJ Mixer.

To convert the .flv file into MP3, WMA, WAV, or OGG
formats, click on the Convert button. Again, an open
file dialog will open, displaying only the .flv files.
Select the file format you want to convert the .flv file
into.

PCLinuxOS FLV Player & ConverterPCLinuxOS FLV Player & ConverterRepo Spotlight:Repo Spotlight:
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Select an option and the file browser will ask you
where you want to save the audio.

Click on the OK button, and the conversion of your
.flv file will begin.

It needs a little time, but when it's finished, it will
display an info window.

Isn't that simple? It's as simple to use as PCLinuxOS
is. That's the reason you should use the PCLinuxOS
FLV Player And Converter.
Of course, it is available in the PCLinuxOS
Repository. Have fun!

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxos­magazine

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:
PCLinuxOS Magazine Forum:

http://pclosmag.com/forum/index.php
Main PCLinuxOS Forum:

http://www.pclinuxos.com/forum/index.php?board=34.0
MyPCLinuxOS Forum:

http://mypclinuxos.com/forum/index.php?board=157.0

Reach Us On The Web

1. All the contents of the NEW PCLinuxOS Magazine are only
for general information and/or use. Such contents do not
constitute advice and should not be relied upon in making (or
refraining from making) any decision. Any specific advice or
replies to queries in any part of the magazine is/are the
person opinion of such experts/consultants/persons and are
not subscribed to by the NEW PCLinuxOS Magazine.

2. The information in the NEW PCLinuxOS Magazine is
provided on an "AS IS" basis, and all warranties, expressed
or implied of any kind, regarding any matter pertaining to any
information, advice or replies are disclaimed and excluded.

3. The NEW PCLinuxOS Magazine and its associates shall not
be liable, at any time, for damages (including, but not limited
to, without limitation, damages of any kind) arising in contract,
rot or otherwise, from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or
refrained from being taken) as a result of using the magazine
or any such contents or for any failure of performance, error,
omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or
use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom the NEW
PCLinuxOS Magazine has no control or connection, business
or otherwise. These sites are external to the NEW
PCLinuxOS Magazine and by visiting these, you are doing so
of your own accord and assume all responsibility and liability
for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Repo Spotlight: PCLinuxOS FLV Player & Converter

http://groups.google.com/group/pclinuxos-magazine
http://pclosmag.com
http://pclosmag.com/forum/index.php
http://www.pclinuxos.com/forum/index.php?board=34.0
http://mypclinuxos.com/forum/index.php?board=157.0
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More Screenshot ShowcaseMore Screenshot Showcase

Top Left: Posted by
Crow, November 4,
2010, running e17.
Top Right: Posted by
loukingjr, November
22, 2010, running
e17.
Bottom Left: Posted
by pirate, November
24, 2010, running
KDE4.
Bottom Right:
Posted by zerocool,
November 4, 2010,
running KDE4.




